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Abstrak 

Perkembangan Teknologi Informasi saat ini berkembang sangat pesat dalam arti 

perkembangan perangkat keras dan perangkat lunak.Perkembangan perangkat keras sangat 

terasa berupa kecanggihan akses dan perkembangan perangkat lunak juga mengalami 

perkembangan tentunya sangat membantu dan berpengaruhdalam meningkatkan 

produktivitas kerja.Peningkatan produktivitas atau kemampuan mengoperasikan aplikasi 

dilakukan dengan cara pelatihan, pelatihan berupa  aplikasi komputer khususnya Adobe 

PHOTOSHOP &AutoCADdengan kasus yang aktual berupa slide untuk pembelajaran 

dengan harapan  hasil yang telah dilaksanakan dapat bermanfaat. Pelatihan ini juga bertujuan 

untuk meningkatkan daya nalar ke teknikan dan rekayasa teknik, sehingga disamping  

mampu meningkatkan produktivitas kerja, juga hasilnya diharapkan mampu bersaing dengan 

para ahli yang sudah lama dibidang ini. Pembelajaran Adobe PHOTOSHOP &AutoCAD ini 

memberikan semangat kewirausahaan didalam penyampaiannya. Adobe PHOTOSHOP & 

AutoCAD merupakan sebuah program CAD (Computer Aided Design) yang sangat terkenal 

dan familier dewasa ini, karena menawarkan berbagai kemudahan dan keunggulan yang bisa 

mempermudah kerja designer dan drafter dalam memvisualisasikan ide dan gagasannya. 

Sejak diciptakan oleh Adobe dan Autodesk Corporation hingga keluarnya release yang 

terbaru,Adobe PHOTOSHOP dan AutoCAD mengalami perkembangan yang sangat berarti 

serta mempunyai peran yang sangat besar bagi perkembangan industri kreatif saat ini. Adobe 

Photoshop dan AutoCAD adalah sebuah program aplikasi (software) yang digunakan untuk 

menggambar dan mendesain gambar, seperti gambar grafis arsitektur, mesin, sipil, elektro 

dan lain-lain, di mana program Adobe Photoshop dan AutoCAD mempunyai kemudahan dan 

keunggulan untuk membuat gambar dengan cepat dan akurat serta bisa digunakan untuk 

memodifikasi gambar dengan cepat pula. Fasilitas yang dimiliki Adobe PHOTOSHOP 

&AutoCAD untuk menggambar 2 dimensi dan 3 dimensi sangat lengkap, sehingga hal ini 

membawa Adobe PHOTOSHOP & AutoCAD menjadi program desain terpopuler 

dibandingkan dengan program-program yang lain dewasa ini. 

 

Kata kunci: CAD, design software, photoshop 

 

Pendahuluan 

Seiring dengan perkembangan era 

globalisasi, dunia Teknologi Informasi dan 

Komunikasi juga berkembang dengan pesat dan 

pada abad 21 ini Teknologi Informasi dan 

Komunikasi sudah menjadi kebutuhan primer 

bagi banyak kalangan. Dengan menggunakan 

Teknologi Informasi dan Komunikasi, suatu 

proses dan kegiatan dapat dilakukan dengan 

lebih cepat, mudah dan efisien. Oleh karena itu 

penguasaan terhadap perangkat teknologi 

komunikasi perlu diajarkan pada semua 

tingkatan khususnya aplikasi computeruntuk 

perkantoran atau bisnis. 

Salah satu aplikasi komputer adalah 

Adobe PHOTOSHOP &AutoCAD, software 

produk Microsoft® yang dikhususkan untuk 

pembangunan atau pembuatan slide untuk 

presentasi. Adobe PHOTOSHOP &AutoCAD 

memiliki beberapa alat bantu (tools) yang 

membantu perancang slide untuk mendesain 

slide sehingga tampil lebih menarik dan mudah 

dikendalikan saat melakukan presentasi. 

 Maksud dari kegiatan ini adalah 

melaksanakan Pengabdian Pada Masyarakat 

dengan memberikan pelatihan aplikasi 

komputer desain (adobe photoshop &  

autoCAD) untuk bisnis industri kreatif kepada 

Guru Madrasah Tsanawiyah atau Aliyah Al-
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Musyarrofah.Tujuan yang ingin dicapai dari 

realisasi pelatihan aplikasi komputer desain 

(adobe photoshop &  autoCAD) ini 

adalah:Memahami dan dapat mengoperasikan 

aplikasi komputer desain(adobe photoshop & 

autoCAD) untuk dapat membuat desain secara 

digital dan mudah dalam pelaksanaannya. 

Adapun Hasil kegiatan yang dapat dirasakan 

oleh Guru-guru setelah mengikuti pelatihan 

adalah: dapat membuat hasil ciptaannya yang 

baik dan menarik. 

 CAD (Computer Aided Design) adalah 

program komputer yang memungkinkan 

seorang perancang (designer) untuk mendisain 

gambar rekayasa dengan mentransformasikan 

gambar geometris secara cepat. Sedangkan 

CAM (Computer Aided Manufacturing) adalah 

sistem manufaktur yang mengoptimalkan 

kemampuan program komputer untuk 

menterjemahkan disain rekayasa yang dibuat 

oleh CAD sehingga dapat mengontrol mesin 

NC (Numerical Controlled Machines). Sistem 

CAD/CAM sendiri terjadi apabila spesifikasi 

disain secara langsung ditransfer/diterjemahkan 

kedalam spesifikasi manufaktur, jadi 

CAD/CAM merupakan penggabungan desain 

rekayasa dan instruksi manufaktur. Sedangkan 

mesin NC sendiri adalah mesin yang 

peralatannya dikontrol oleh komputer dengan 

sistem CAD/CAM. 

 Untuk orang awam CAD/CAM 

dianggap alat gambar elektronik saja yang 

dapat mempercepat proses menggambar, tetapi 

kenyataannya kemampuan CAD/CAM jauh 

melebihi anggapan tersebut dimana CAD/CAM 

mempunyai fungsi utama dalam disain, analisa, 

optimasi dan manufaktur. CAD/CAM biasa 

melakukan analisa elemen hingga (finite 

element analysis), analisa transfer panas (heat 

transfer analysis), analisa tekanan (stress 

analysis), simulasi dinamis dari mekanik 

(dynamic simulation of mechanisms), analisa 

cairan dinamis (fluid dynamic analysis) dan 

lain-lain. 

CAD merupakan wakil dari evolusi 

komputer grafik, yang diciptakan didalam 

industri penerbangan dan otomotif sebagai 

suatu cara untuk meningkatkan perkembangan 

teknologi dan untuk mengurangi banyak 

pekerjaan yang membosankan dari para 

disainer. Pada pertengahan tahun 1950 SAGE 

(Semi Automatic Ground Environment) dari 

Departemen Pertahanan Udara USA 

menggunakan komputer grafik dan mengubah 

informasi radar menjadi gambar komputer. 

Patrick Hanratty pada tahun 1960 melakukan 

penelitian dan pengembangan dari CAD sambil 

bekerja di laboratorium riset General Motor. 

Pada tahun 1963 Ivan Sutherland seorang 

Doktor memulai basis teori dari komputer 

grafik. Tetapi pada tahun 1960 an ini biaya 

investasi CAD/CAM sangat mahal dan hanya 

perusahaan-perusahaan besar saja yang sanggup 

membeli. Tetapi pada tahun 1970 an sampai 

dengan saat sekarang dimana kemampuan 

komputer semakin canggih, dengan prosesor 

yang semakin cepat, memori makin besar, 

ukuran makin kecil dan kompak serta harga 

yang semakin murah memungkinkan 

perusahaan-perusahaan kecil untuk melakukan 

investasi teknologi CAD/CAM ini. 

 

Teknologi CAD/CAM 

 Kemampuan CAD/CAM yang terdiri 

dari 3 teknologi dasar yaitu : 

1. Manajemen Basis Data (Database)  

2. Komputer Grafik  

3. Model Matematis (Analisis) 

4. Akuisisi Data dan Kontrol (prototipe fisik, 

proses produksi) 

 

Seringkali aplikasi CAD/CAM dapat 

memanfaatkan keempat teknologi dasar dari 

CAD/CAM diatas seperti menyimpan dan 

memanggil basis data gambar dan atribut suku 

cadang, menggunakan komputer grafik untuk 

berkreasi dan display, memanfaatkan simulasi 

dan model matematis (elemen hingga) dan 

dapat juga dimanfaatkan untuk mengontrol 

proses produksi dengan kontrol numerik dan 

pemrograman robot. Contoh lain adalah MRP 

(Material Requirements Planning) yang hanya 

memanfaatkan teknologi dasar dari CAD/CAM 

yaitu Manajemen Basis Data. Selanjutnya tanda 

“/” didalam CAD/CAM menunjukkan 2 

kemampuan yang diintegrasikan. Database 

alfanumerik yang diciptakan dalam disain dapat 

menjadi aplikasi Permintaan Bahan Baku (Bill 

of Material) dalam industri manufaktur. 

Gambar geometris diterjemahkan menjadi 

spesifikasi manufaktur sehingga dapat 

mengontrol mesin CNC (Computer Numerical 

Control). Selain itu kemampuan CAD dalam 

mendisain Wireframe Modelling berkembang 
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menjadi Surface Modelling, Solid Modelling 

dan terakhir Parametric Modelling. Sedangkan 

kemampuan CAM dari mesin NC (Numerical 

Control) menjadi CNC (Computer Numerical 

Control) dan terakhir DNC (Direct Numerical 

Control). 

 

Manfaat dan Dampak CAD/CAM dalam 

Kompetisi 

 Konsumen selalu mencoba membeli 

produk “terbaik”. Definisi terbaik sangat 

berbeda antara seorang konsumen dengan 

konsumen lainnya. Satu konsumen 

membutuhkan waktu pengiriman yang singkat, 

yang lain membeli karena harga, lainnya mutu 

dan lain-lain. Oleh karena setiap perusahaan 

harus mencari keunggulan strategis masing-

masing serta celah pasar (niche). Tidak setiap 

perusahaan dapat memperoleh disain dengan 

biaya yang terendah dan produk bermutu. 

Setiap perusahaan harus menentukan strategi 

generik mereka apakah fokus, diferensiasi 

ataukah pemimpin biaya [Michael E. Porter]. 

Manfaat dan keunggulan dari teknologi 

CAD/CAM yang dapat menciptakan 

keunggulan bersaing adalah sebagai berikut : 

A. Respon cepat 

Perusahaan-perusahaan yang banyak 

kehilangan order karena keterlambatan 

pengiriman dapat memanfaatkan teknologi 

CAD/CAM untuk mempercepat proses 

disain dan siklus manufaktur. Biasanya 

keterlambatan bersumber pada pembuatan 

gambar yang lama, uji prototipe, proses 

pemberitahuan perubahan produk dan lain-

lain, dalam hal ini kita dapat mengandalkan 

CAD/CAM untuk mempercepatnya. 

Sebagai contoh, jika test prototipe/produk 

yang menjadi masalah kritis maka CAD 

dapat mempercepatnya dengan membuat 

simulasi komputer. 

B. Disain manufaktur yang lebih fleksibel 

dan besar 

Secara tradisional proses produksi 

dilakukan dengan 2 macam mesin yaitu 

General Purpose Machine untuk produksi 

batch dan Dedicated Machine untuk 

produksi masal. 

 

Cara Membuat Digital Coloring Melalui 

adobe photoshop 

Langkah awal mewarnai desain sepatu 

secara digital adalah sebagai berikut, tekniknya 

mudah dan dapat diikuti melalui metode berikut 

ini. 

A. Langkah 1 :Vector Line 

 
Ikuti petunjuk dibawah ini : 

- Untuk membuka gambar, caranya :File> 

Open. 

- Gunakan View > Fit On Screen untuk 

mencocokkan frame gambar dengan frame 

monitor komputer. 

B. Langkah 2 :Flat Grey 

 

- Buatlah Layer 1 (create a new layer) 

- Lalu gunakan Brush Tool dengan warna 

abu-abu, kurangi layer opacitynya 

menjadi 50% 

- Berikutnya gunakan Magic Wand Tool 

untuk memilih bagian terluar sepatu, 

lalu edit > cut. 

C. Langkah 3 : First Light 
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- Buat New Layer 

- Gunakan Polygonal Lasso Tool untuk 

bagian atas cahaya (sesuai gambar), 

berbentuk oval. 

- Lalu pilih select > inverse, selanjutnya 

edit > cut. 

- Kurangi layer opacity-nya menjadi 80-

90% 

D. Langkah 4 : More Grey 

 
- Buat New Layer 

- Gunakan Magic Wand Tool untuk 

memilih area yang ingin digelapkan 

(select layer masternya dulu, lalu 

kembali ke new layer) 

- Pakailah Paint Bucket Tool untuk 

bagian abu-abu yang lebih gelap 

E. Langkah 6 :Highlight 

 

- Gelapkan bagian dalam sepatu seperti 

langkah 5 (New Layer) 

- Buatlah cahaya kecil dibagian kiri 

bawah sepatu menggunakan Polygonal 

Lasso Tool, lalu pakai Brush Tool 

dengan warna putih (new layer), 

kurangi opacity layer-nya menjadi 80-

90%(New Layer) 

- Selanjutnya, untuk membuat garis nuts 

(antara garis hitam (shadow) dan garis 

putih (highlight)), gunakan Pen Tool. 

- Ikuti gambar garisnya, lalu klik kanan > 

stroke path(New Layer). 

- Stroke Path berpatokan dengan Pencil 

Tool, aturlah terlebih dahulu master 

diameterPencil Tool tersebut (master 

diameter di set menjadi “3”) 

- Untuk menghilangkan garis Pen Tool, 

caranya klik kanan > Delete Path. 

- Ulangi langkah-langkah tersebut untuk 

membuat garis nuts yang baru (selalu 

gunakan New Layer) 

 

F. Langkah 7 : Lights Every Direction & 

Blending Options 

 

- Setelah selesai membuat garis nuts, 

buatlah garis putih dibagian belakang 

sepatu. Caranya sama, gunakan Pen 

Tool > Stroke Path (seperti langkah 6, 

tapi hanya 1 warna saja yakni putih) 

- Buatlah cahaya highlight kecil di bagian 

bawah depan sepatu (caranya ikuti 

langkah 6 yang membuat cahaya 

highlight) 

- Logo Nike dibuat embose, caranya pilih 

layer logo nike tersebut> klik kanan > 

Blending Options > Bevel and Emboss 

>atur size dan soften 

- Selanjutnya, gunakan eraser untuk 

memutihkan bagian abu-abu tengah 

sepatu (karena datangnya cahaya supaya 

gambar lebih “hidup”), gunakan eraser 

dengan opacity rendah (20-40%). 

-  

G. Langkah 8 : Sustainable Lights 
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- Bagian ini adalah bagian untuk 

menggelapkan area yang tidak terkena 

cahaya. 

- Gelapkan bagian kiri bawah sepatu 

(Gunakan Brush Tool dan Magic Wand 

Tool) 

- Gelapkan bagian dalam sepatu 

(Gunakan Brush Tool dan Magic Wand 

Tool) 

- Gelapkan bagian luar belakang sepatu 

(Gunakan Brush Tool dan Magic Wand 

Tool) 

 

H. Langkah 9 : Insert Color 

 

- Masukkan warna (warna bebas, boleh 

merah, biru, kuning,dll.) 

- Caranya New Layer > Brush Tool. 

- Jangan lupa hilangkan bagian terluar 

sepatu seperti langkah 2. 

- Layernya di posisikan tepat diatas 

master layer (kadang harus disesuaikan 

dengan kita sendiri, tidak ada patokan) 

 

I. Langkah 10 : Insert Secondary Lights 

 

- Masukkan warna cahaya alternatif, 

seperti hijau.Caranya : menggunakan 

Brush Tool (New Layer) 

J. Langkah 11 :Insert Shadow 

 

- Terakhir, pakailah Brush Tool untuk 

bagian bayangan (New Layer), dan 

untuk bagian cahaya paling 

belakang/belakang sepatu (New Layer) 

- Jangan lupa atur Layer bayangan 

dibawah Layer-layer sepatu lainnya. 

Beda dengan layer cahaya, harus 

diposisikan diatas layer-layer sepatu 

lainnya. 

Cara Membuat Rekayasa Teknik pada 

Autocad 

 
Gambar 1 

Tampilan dasar AutoCAD Cla 

 

Keterangan : 

Baris Judul (Title Bar ) 

Merupakan baris judul dari program AutoCAD 

2010. Berisikan tulisan AutoCAD 2010 serta 

nama file yang sedang aktif pada saat ini. 

 

Baris Status (Status Bar) 

Semi tentang informasi mengenai status 

(keadaan) pada saat ini dari beberapa fungsi 

khusus, seperti grid, ortho, snap dan lain-lain. 
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Area Gambar (Drawing Area) 

Tempat untuk menampilkan gambar, 

melakukan penggambaran dan pengeditan 

gambar. 

 

Pop-up Menu (Menu Pull Down) 

Baris menu yang berisi tentang fungsi-

fungsi untuk menggunakan AutoCAD, antara 

lain perintah untuk penggambaran, mengubah 

setting, menyimpan dan menampilkan file 

gambar dan sebagainya. 

 

Toolbar 

Tombol-tombol yang berisi perintah-perintah 

AutoCAD yang dapat dipergunakan secara 

cepat.Ditampilkan dengan bentuk simbol-

simbol dalam sebuah kotak. 

 

Baris Perintah (Command Line) 

Merupakan baris perintah dari AutoCAD, 

yang berfungsi untuk memasukkan perintah-

perintah AutoCAD, seperti LINE, 

CIRCLE,RECTANGLE dan 

sebagainya.Selain itu berfungsi juga 

untuk memberikan tanggapan terhadap 

perintah-perintah tersebut. 

 

Control Menu Icon 

Adalah icon yang digunakan untuk 

mengontrol keadaan jendela dari program 

AutoCAD 2010. Icon ini jugamerupakan salah 

satu fasilitas standard dari setiap program 

aplikasi berbasis Windows. 

 

Tahapan Untuk MenjalankanProgram 

AutoCAD 

 Program AutoCAD bisa dijalankan 

setelah masuk ke dalam sistem - operasi 

Windows terlebih dahulu. Adapun langkahnya 

adalah sebagai berikut : 

 Komputer dihidupkan, 

 Kemudian masuk ke dalam sistem operasi 

Windows, 

 Klik tombol Start yangterletak pada 

taksbar, 

 Klik program, setelah tampil menu pilih 

AutoCAD, kemudian dalam grup ini pilih 

grup AutoCAD di dalamnya. 

 Atau klik dua kali ( dobel ) pada icon 

AutoCAD. 

 

 
 

 
Gambar 3 

Tampilan default AutoCAD 2007 Classic 

 

A. Mengubah Warna Model Area 

 Perubahan warna model area perlu 

dilakukan karena warnanya hitam, sedangkan 

media untuk penuangan gambar pada umumnya 

berwarna putih.Langkah perubahan tersebut 

adalah sebagai berikut : 

1. Tekan tombol+9, atau klik menu bar 

Tools>Options.... 

2. Pada kotak dialog Options yang ditampilkan 

pastikan tab Display aktif dengan cara 

mengkliknya. Kemudian klik tombol 

Colors... maka tampil kotak dialog Drawing 

Window Colors seperti pada Gambar 1.3, 

jika Anda menggunakan AutoCAD 2007, 

akan tampil kotak dialog Color Options 

seperti pada Gambar 1.4 jika Anda 

menggunakan AutoCAD rilis sebelumnya. 

3.  

 
Gambar 4 

Kotak dialog Drawing Window Colors 
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Apabila Anda menggunakan AutoCAD 2007, 

berikut ini langkah yang perlu Anda lakukan. 

1. Pastikan pilihan pada kotak Context adalah 

2D Model Space. 

2. Pastikan pilihan pada combo Interface element 

adalah Uniform background 

3. Kemudian pilih warna White pada combo 

Color. Setelah itu klik tombol Apply and 

Close 

4. Setelah kembali pada kotak dialog Options 

klik tombol OK. 

 
Gambar 5 

Kotak dialog Color Options 

 

Apabila Anda menggunakan AutoCAD rilis 

sebelumnya, berikut ini langkah yang perlu 

Anda lakukan. 

1. Pastikan pilihan pada combo Window 

Element adalah Model tab 

Background,kemudian pilih warna White 

pada combo Color. Setelah itu klik tombol 

Apply& Close. 

2. Setelah kembali pada kotak dialog 

Options, klik tombol OK. 

 

B. Konsep Dasar Penggunaan AutoCAD 

 Untuk bisa menjalankan program 

AutoCAD 2000, hal mendasar yang harus 

dikuasai adalah  pengetahuan tentang tampilan 

layar AutoCAD 2000.Karena kita tidak bisa 

mengoperasikan program AutoCAD 2000 

dengan baik, tanpa mengetahui elemen-elemen 

yang ada dalam layar tersebut. Adapun elemen 

elemen tersebut dapat dilihat pada tampilan 

ayar AutoCAD 2000 sebagai berikut : 

 

C. Sistem Koordinat 

 Sistem koordinat yang dipakai oleh 

AutoCAD adalah WCS (World Coordinat 

Sistem), yaitu system koordinat dengan sumbu 

X, Y dan Z di manamasing-masing sumbu 

koordinat tersebut berpotongan di titik (0,0) 

atau titikorigin. Sedangkan arah positif dari 

masing-masing sumbu tersebut dinyatakanoleh 

arah anak panah.Adapun sistem koordinat yang 

terdapat dalam AutoCAD ada tiga macam : 

1. Koordinat Kartesius/ Cartesian, yaitu sistem 

koordinat yang menunjukkanposisi suatu 

titik. Adapun format koordinat kartesius 

adalah (X,Y)(X,Y,Z). 

2. Koordinat Polar, yaitu sistem koordinat 

yang digunakan untukmenunjukkan suatu 

jarak dengan sudut tertentu dari titik 

terakhir. Adapunformat dari koordinat polar 

adalah @ jarak < sudut. 

3.  Koordinat relatif, yaitu sistem koordinat 

yang digunakan untukmenunjukkan jarak 

relatif dari titik terakhir ke arah X,Y atau 

X,Y,Z.Adapun format penulisannya adalah 

@ panjang, lebar, tinggi. 

 

D. Sistem Perputaran 

 Sistem perputaran sudut yang digunakan 

dalam penggambaran AutoCAD untuk gambar 

dua dimensi adalah sistem perputaran yang 

berlawanan dengan -jarum jam atau CCW 

(Counter Clock Wise). 

 

E. Pengaturan Bidang Gambar 

 Untuk mempermudah proses 

penggambaran di dalam AutoCAD, sertauntuk 

memperoleh hasil gambar yang betul-betul 

presisi sesuai dengan yangdirencanakan, maka 

sebelum memulai menggambar harus dilakukan 

pengaturan terlebih dahulu. Adapun yang harus 

dilakukan dalam proses pengaturan tersebut 

adalah : 

1. Pengaturan Batas Bidang Gambar 

 Pengaturan batas bidang gambar ( Drawing 

Limits ) mutlak perlu dilakukan  apabila 

objek yang akan digambar lebih besar dari 

betas limit standard. 

2.  Pengaturan Units 

 Pengaturan ini berfungsi untuk menentukan 

system units atau system satuan yang akan 

digunakan dalam menggambar. Dalam 

kotak dialog drawing units tersebut juga ada 

Precision yang berfungsi untuk mengatur 

presisi gambar atau tingkat ketelitian. 

3. Pengaturan Snap dan Grid 
 Fungsi pengaturan Snap dan Grid adalah 

untuk membuat gambar yang 
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presisi.Pengaturan ini bisa dilakukan 

melalui kotak dialog Drafting Setting,di 

mana grid merupakan satuan yang 

dipergunakan pada saat 

menggambar,sedangkan snap berfungsi 

untuk membuat gambar selalu lurus, baik 

horizontal maupun vertical. 

 

F. Perintah Menggambar 

 Untuk melakukan penggambaran dalam 

AutoCAD, perintah-perintahgambar bisa 

diambil melalui beberapa cara, yaitu dari Menu 

Pull-Down, Toolbar Draw, Screen Menu (menu 

layar ), maupun dengan cara mengetik langsung 

pada keyboard. Adapun perintah gambar 

tersebut meliputi : 

1. LINE 

Untuk membuat sebuah garis dengan cara 

menentukan dua buah titik ujung,dimana ujung 

dari garis sebelumnya merupakan titik awal dari 

garis berikutnya. 

 

2. RAY 

Garis bantu dari satu titik tumpu ke satu arah 

yang lain dengan – panjang tidak terbatas. 

 

3. CONSTRUCTION LINE 

Garis bantu dari satu titik tumpu ke dua arah 

yang lain dengan panjang tidak terbatas. 

 

4. MULTILINE 

Garis double yang bisa ditentukan posisi 

kursor, (skala jarak antar garis) maupun jenis 

garisnya. 

 

5. POLYLINE 

Garis satu kesatuan yang dapat diatur 

ketebalanya pada awal - maupunujungnya. 

Jenis lain dari polyline adalah 3D Polyline, 

dimana sifatnya sama dengan garis polyline 

tetapi pengaturan ketebalanya dapat dilakukan 

terhadaptinggi obyek. 

 

6. POLYGON 

Polygon adalah perintah untuk membuat segi 

banyak dimana semua sisinya sama panjang. 

Adapun jumlah sisinya minimal 3 sedangkan 

maksimalnya adalah 1024. 

 

7. RECTANGLE 

Rectangle adalah perintah untuk membuat 

kotak dengan cara menentukan titik diagonal. 

Rectangle dibuat dari Polyline, yaitu obyek 

yang semua segmenya merupakan satu besaran. 

 

8. ARC 

Arc adalah perintah untuk membuat busur 

lingkaran atau garis - lengkung. 

 

 

9. CIRCLE 

Circle adalah perintah untuk membuat lingkaran 

atau objek bulat yang tertutup. 

 

10. DONUT 

Donut adalah perintah untuk membuat 

lingkaran dengan ketebalan tertentu.Dalam 

pembuatan ini harus ditentukan diameter dalam 

(Inside diameter) serta diameter luar (Outside 

diameter). 

 

11. SPLINE 

Spline adalah perintah untuk membuat kurva 

spline dengan mengikutibeberapa titik kontrol 

yang dimasukkan sesuai dengan besar - 

toleransinya. 

 

12. ELLIPSE 

Ellipse adalah perintah untuk membuat elips, 

yaitu suatu kurva ( obyek tertutup yang 

melengkung) yang memiliki dua sumbu, yaitu 

sumbu mayordan sumbu minor. 

 

13. POINT 

Point adalah perintah untuk membuat sebuah 

titik. Adapun defaultnya bentuk titik adalah 

noktah, akan tetapi bentuk tersebut bisa diubah 

sesuai dengan keinginan. 

 

G. Pengeditan Gambar 

Dalam proses pembuatan gambar dengan 

AutoCAD, sering kali dijumpai kesalahan-

kesalahan yang mungkin tidak disengaja. Oleh 

karena itu AutoCAD menyediakan fasilitas 

pengeditan gambar yang bisa diambil melalui 

menu Modify. Perintah tersebut bisa diambil 

dari menu bar atau diketik langsung melalui 

keyboard. 

 

H. Perintah Edit Gambar 

1. ERASE 

Erase adalah perintah untuk menghapus satu 

atau sekumpulan obyek yang telah dibuat. 
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2. COPY 

Copy adalah perintah untuk memperbanyak 

obyek atau menyalin satu /sekumpulan obyek. 

 

3. MIRROR 

Mirror adalah perintah untuk mencerminkan 

satu atau sekumpulan obyek,yaitu membuat 

obyek baru yang sama dengan obyek yang 

dipilih tetapi posisinya terbalik. Cara 

pembuatanya adalah dengan membuat dua titik 

di layar sebagai sumbunya (cermin). Posisi 

obyek baru tergantung dari posisi cermin 

tersebut. 

 

4. OFFSET 

Offset adalah perintah untuk menyalin obyek 

secara pararel. Selain bisadimasukkan langsung 

jarak offsetnya, bisa juga dilakukan dengan 

cara menunjuk langsung di layar. 

 

5. ARRAY 

Array adalah perintah untuk menyalin atau 

memperbanyak secara massal dengan pola atau 

susunan yang teratur. Adapun Array ada dua 

jenis, yaitu Array Rectangular (pola grid) dan 

Array Polar (pola melingkar). 

 

6. MOVE 

Move adalah perintah untuk memindahkan 

suatu obyek atau sekumpulanobyek dari suatu 

tempat ketempat yang lain. 

 

7. ROTATE 

Rotate adalah perintah untuk memutar satu atau 

sekumpulan obyek dengancara menentukan 

titik acuan (base point) sebagai sumbu putar, 

sedangkan sudut puternya bisa ditentukan 

dengan memasukkan angka melalui keyboard 

atau diklik langsung di layar. 

 

8. SCALE 

Scale adalah perintah untuk mengubah ukuran 

satu atau sekumpulan obyek (memperbesar 

maupun memperkecil) secara beraturan, dengan 

caramenentukan faktor skala. Apabila skala 

lebih besar dari 1 (satu), maka obyek akan 

diperbesar, tetapi apabila kurang dari 1 (satu) 

maka obyek akan diperkecil. 

 

9. STRETCH 

Stretch adalah perintah untuk mengubah 

sebagian dari obyek, baik memperbesar atau 

memperkecil. Adapun metoda yang digunakan 

untuk memilih obyek tersebut adalah crossing. 

 

10. LENGTHEN 

Lengthen adalah perintah untuk mengubah 

panjang garis atau busur. Ada beberapa metoda 

perubahan panjang, apakah delta panjang, 

panjang total, persentasi perubahan panjang 

maupun perubahan panjang secara dinamik. 

 

11. TRIM 

Trim adalah perintah untuk memotong obyek 

dengan menggunakan obyek pembatas. 

 

12. EXTEND 

Extend adalah perintah untuk memperpanjang 

obyek dengan menggunakan obyek pembatas. 

Adapun yang dimaksud dengan pembatas 

tersebut adalah obyek yang memiliki potensi 

untuk berpotongan dengan obyek yang akan 

diperpanjang. 

 

13. BREAK 

Break adalah perintah untuk memotong obyek 

tanpa obyek pembatas atau untuk memotong 

obyek yang berada diantara dua titik yang 

ditentukan. 

 

14. CHAMFER 

Chamfer adalah perintah untuk memangkas 

sudut atau untuk menghubungkan dua garis 

dengan garis lurus baru yang mempunyai 

kemiringan tertentu. 

 

15. FILLET 

Fillet adalah perintah untuk melengkungkan 

sudut atau untuk menghubungkan ujung-ujung 

dari dua buah obyek dengan sebuah busur. 

 

I. Fasilitas Obyek Snap (Osnap) 

Obyek Snap (OSNAP) adalah fasilitas bantu 

AutoCAD yang berfungsi untuk mengunci 

obyek pada titik tertentu sehingga kursor akan 

menangkap titik tersebut. Agar hasil gambar 

yang dibuat bisa akurat dan sempurna, maka 

fasilitas ini mutlak dibutuhkan. Osnap terdiri 

dari dua jenis, yaitu Osnap Sementara dan 

Osnap Permanen. Osnap sementara hanya 

berlaku untuk satu kali tangkapan saja 

sedangkan Osnap permanen dapat diaktifkan 

sebelum menggambar, dan akan terus aktif 

sampai dimatikan kembali. 
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Fasilitas : 

Endpoint : untuk menangkap titik ujung. 

Midpoint : untuk menangkap titik tengah. 

Intersection : menangkap titik perpotongan 

antara dua obyek 

berpotongan. 

Apparent Intersection : menangkap titik 

perpotongan dua obyek yang 

tidak ketemu. 

Center : untuk menangkap titik pusat. 

Quadrant : menangkap titik kuadran 

lingkaran, yaitu 0, 90, 

180 dan 270. 

Tangent : menangkap titik singgung lingkaran 

atau busur. 

Perpendicular : menangkap titik yang tegak 

lurus terhadap garis 

lingkaran dan busur. 

Node : untuk menempatkan sesuatu pada titik. 

Insert : untuk menangkap titik sisip. 

Nearest : untuk menangkap titik terdekat dari 

sebuah 

obyek. 

None : untuk mematikan Osnap yang sedang 

bekerja 

secara permanen. 

 

J. Pengaturan Tampilan Gambar 

 Hal yang tidak kalah pentingnya dengan 

perintah menggambar, mengeditdan beberapa 

fasilitas bantunya adalah pengaturan layar 

(bidang gambar), seperti mengatur besar 

gambar di layar agar sesuai dengan kebutuhan, 

menggeser layar dan sebagainya. Untuk 

memperbesar area pengamatan gambar agar 

lebih mudah dilakukan proses penyuntingan 

atau pengeditan obyek, maka disediakan 

fasilitas Zoom yang terdapat dalam menu View. 

Adapun fungsi zoom yang spesifik adalah 

untuk mengendalikan / mengatur tampilan. 

 

K. Perintah Zoom 

 Real Time : untuk melakukan zoom 

secara interaktif, gerakan ke atasakan 

memperbesar tampilan, gerakan ke 

bawah akanmemperkecil. 

 Previous : untuk mengembalikan 

pandangan di layar pada zoom -

sebelumnya. 

 Window : untuk mengatur tampilan 

dengan cara membuat jendela. 

 Dynamic: untuk memperbesar/ 

memperkecil pandangan 

denganmengubah ukuran focus. 

 Scale : untuk melakukan zoom dengan 

cara memasukkan angkasebagai faktor 

skala. 

 Center : untuk menampilkan gambar 

dengan menentukan titik pusatlayar serta 

tinggi layar. 

 In/ Out: untuk memperbesar/ 

memperkecil tampilan dengan 

mengisifaktor. 

 All : untuk menampilkan seluruh 

gambar beserta daerahlimitsnya. 

 Extents : untuk menampilkan seluruh 

gambar secara maksimal dilayar tanpa 

ada bagian yang terpotong. 

 

L. Perintah Pan 

 Perintah Pan digunakan untuk 

menggeser bidang gambar tanpa terjadi 

perubahan pengamatan bidang gambar. Perintah 

Pan diambil dari menu View. Pilihan yang 

tersedia dalam perintah Pan adalah : 

 Real Time : untuk menggeser layar secara 

dinamik. 

 Point : untuk menggeser layar dengan cara 

menentukan dua titik dilayar. Layar akan 

bergeser sejauh jarak antara titik pertamadan 

titik kedua. 

 Left : untuk menggeser layar dengan cara 

menentukan dua titik dilayar. Layar akan 

bergeser sejauh jarak antara titik pertamadan 

titik kedua. 

 Right : untuk menggeser bidang gambar ke 

kanan layar. 

 Up : untuk menggeser bidang gambar ke atas 

layar. 

 Down : untuk menggeser bidang gambar ke 

bawah layar. 

 

M. Aerial View 

 Aerial View berfungsi untuk melakukan 

pengamatan secara langsung terhadap tampilan 

bidang gambar (zoom dan pan). Setelah jendela 

Aerial View tampil di layar monitor, ukuran 

maupun letaknya bisa diatur sesuai keinginan. 

Adapun salah satu kelebihan Aerial View 

adalah pada saat melakukan proses 

penggambaran dapat dilakukan zoom dan pan 
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secara langsung tanpa harus mengambil 

perintah dari menu bar. 

 

N. Pengaturan Tampilan Gambar Yang 

Lain 

 Redraw : untuk membersihkan tampilan 

gambar pada saatpengeditan 

berlangsung 

 Regen : untuk meregenerasi gambar 

setelah dilakukan pengeditanpada salah 

satu viewport yang aktif 

 Regenall : untuk meregenerasi gambar 

setelah dilakukan pengeditanpada 

semua viewports 

 

O. Membuat Layer 

 Layer adalah suatu lapisan pada gambar 

yang berfungsi untuk mengelompokkan gambar 

menurut kriteria tertentu, misalnya berdasarkan 

jenis obyeknya, bidang pekerjaanya dan 

sebagainya. Lapisan tersebut bisa diibaratkan 

sebagai kertas transparan. Lapisan gambar di 

sini bisa diaktifkan, disembunyikan, diatur 

warnanya serta tipe garisnya. Defaultnya 

AutoCAD menyediakan sebuah lapisah 

bernama 0, apabila kita tidak membuat lapisan 

baru, maka gambar kita akan ditempatkan pada 

lapisan 0. 

 Layer juga bermanfaat untuk membantu 

kita apabila kita membutuhkan sebuah gambar 

yang sama untuk beberapa lembar yang 

berbeda, misalnya jikakita akan membuat denah 

lantai tipikal untuk gedung bertingkat banyak. 

Adapun cara membuat lapisan layer baru bisa 

dilakukan dengan membuka menu Format 

kemudian pilih Layer dan ketik nama layer 

tersebut. 

 

P. Text Dan Dimensi 

 Suatu tahapan akhir dari proses 

pembuatan gambar adalah finishing, di mana 

pada tahapan ini dilakukan proses pemberian 

keterangan pada gambar baikberupa teks untuk 

keterangan, maupun dimensi untuk ukuran 

gambar. 

 

Q. Perintah Text 

 Text adalah perintah untuk menuliskan 

huruf atau teks. Di dalam perintah ini bisa 

ditentukan beberapa karakteristik teks seperti 

lokasi penyisipan teks, tinggi teks, arah atau 

sudut teks maupun style dari teks. Adapun 

perintah text bisa diambil dari menu Draw 

kemudian dipilih text. Di dalam penulisan text 

ini AutoCAD menyediakan dua jenis system 

penulisan, yaitu Single Line Text serta Multi 

Line Text.  

 Single Line Text berfungsi untuk 

menuliskan teks satu baris, sedangkn Multi Line 

Text berfungsi untuk menuliskan teks dalam 

bentuk paragrap, di mana di dalam Multi Line 

Text ini disediakan kotak dialog Multiline Text 

Editor yang berfungsi untuk pengaturan dan 

pengeditan teks yang ditulis. Pengaturan di sini 

meliputi pemilihan jenis huruf, ukuran, 

penebalan, garis bawah serta cetak miring, 

penyisipan simbol-simbol maupun efek-efek 

penulisan yang lain. 

 

R. Penulisan Karakter Khusus Teks 

 Karakter khusus yang terdapat dalam 

proses penggambaran kadang sangat 

diperlukan, untuk itu AutoCAD menyediakan 

beberapa efek khusus untuk membuat karakter 

yang tidak terdapat pada keyboard sebagai 

berikut : 

%%o : untuk membuat teks bergaris atas 

%%u : untuk membuat teks bergaris bawah 

%%d : untuk menuliskan derajat (o) 

% %p : untuk menuliskan karakter plus minus 

(±) 

% % c : untuk menuliskan karakter diameter 

(Ø) 

%%% : untuk menuliskan karakter persen (%) 

 

S. Pengaturan (Lay Out) Text 

 Pengaturan tata letak (lay out) teks 

dalam AutoCAD bersifat kondisional, artinya 

pada waktu menuliskan keterangan gambar 

sering kali letak teks dibatasi oleh bentuk dan 

ukuran gambar, oleh karena itu sebaiknya 

sebelum melakukan penulisan text dilakukan 

pengaturan tata letak teks yang akan ditulis. 

Dengan memilih Single Line Text, kemudian 

ketikJustify, maka akan ditampilkan beberapa 

pilihan pengaturan teks sesuai dengan yang 

dinginkan. Adapun jenis-jenis pilihan tersebut 

adalah : 

 

T. Dimensi (Ukuran) 

 Dimensi berfungsi untuk mengukur dan 

menuliskan hasil pengukuran ke dalam area 

gambar (layar). AutoCAD mempunyai 

pengukuran semi otomatik, hal ini berarti 
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AutoCAD mampu mengukur secara akurat 

sekaligus menuliskan hasil pengukuran tersebut 

ke dalam gambar. Bentuk dan tampilan dimensi 

tersebut bisa dirubah sesuai dengan kebutuhan. 

Adapun cara untuk merubah format tampilan 

tersebut bisa dilakukan dengan membuka menu 

Format kemudian pilih Dimension Style. 

Setelah keluar 

kotak dialog Dimension Style Manager, maka 

bisa dilakukan pengaturan komponen dimensi 

utama, yaitu Garis dimensi, Garis ekstension, 

Teks dimensi maupun tanda panah. Dimensi 

bisa diakses langsung dari menu pull-down 

maupun dari floating toolbar, yaitu dengan cara 

klik menu View lalu pilih toolbar kemudian 

pilih Dimension. Bentuk floating toolbars 

dimensi adalah sebagai berikut : 

Keterangan : 

 Linear : untuk mengukur garis vertikal dan 

horisontal 

 Aligned : untuk mengukur garis 

miring/diagonal 

 Ordinate : untuk mengetahui koordinat pada 

suatu titik 

 Radius : untuk mengukur radius lingkaran 

atau busur 

 Diameter : untuk mengetahui diameter 

lingkaran atau busur 

 Angular : untuk mengukur sudut 

 Baseline : untuk membuat dimensi dengan 

titik awal sama 

 Continue : untuk membuat dimensi 

beraturan 

 Leader : untuk memberikan keterangan 

gambar 

 

U. Mencetak Gambar 

1. Melakukan Pencetakan 

 Suatu tahapan terakhir dalam proses 

pembuatan gambar adalah melakukan 

pencetakan pada lembar kerja ( kertas ). Dalam 

tahap ini pengaturan skala cetak harus 

dilakukan, sehingga skala gambar hasil cetakan 

bisa sesuai dengan yang diinginkan. Untuk 

mencetak sebuah gambar bisa dilakukan 

dengan mengambil perintah dari menu File 

kemudian diplih Plot, setelah itu akan keluar 

kotak dialog Plot dan pengaturan pencetakan 

bisa mulai dilakukan. Plot adalah perintah 

untuk mencetak gambar ke dalam lembar kerja 

dengan alat pencetak yang telah dikonfigurasi 

ke dalam sistem, baik printer plotter maupun ke 

dalam file. Hanya file aktif yang akan dicetak 

oleh AutoCAD, tetapi kita bisa memilih daerah 

tertentu pada area gambar yang akan dicetak 

dengan pilihan Limits, Display, Extents maupun 

Window. 

 

2. Menghitung Skala Cetak 

 Skala cetak mempunyai peran yang 

sangat penting bagi gambar-gambar berskala 

tertentu, sebab perbedaan ukuran gambar bisa 

menyebabkan melesetnya beberapa perhitungan 

desain dan perkiraan biaya. Hal yang sangat 

penting diperhatikan dalam pencetakan adalah 

penghitungan skala cetak yang tepat. Apapun 

jenis satuan panjang yang kita gunakan (cm, m, 

km ) tidak jadi masalah yang penting adalah 

pada saat mencetak satuan tersebut di-

konversikan ke dalam millimeter. Apabila 

gambar kita mempunyai skala tertentu, maka 

dapat digunakan persamaan dasar sebagi 

berikut: 

 

Satuan gambar di layar (mm) = Skala 

gambar 

 Misalnya skala gambar denah 1:100, 

gambar tersebut dengan satuan meter (1 unit di 

Iayar = 1m). Maka konversikan dulu 1 m = 

1000 mm. Jadi skala cetak adalah 1000 = 100, 

di mana 1000 adalah hasil konversi dari meter 

ke millimeter dan 100 merupakan skala gambar 

yang digunakan. 

 

Kesimpulan 

 Dengan bertambahnya kemampuan 

menggunakan program Adobe Photoshop dan 

AutoCad diharapkan para guru di Madrasah 

Tsanawiyah atau Aliyah Al-Musyarrofah dapat 

mengunakan pengetahuan ini untuk diberikan 

kepada para siswanya, atau dapat dimanfaatkan 

oleh mereka untuk mendapatkan penghasilan 

tambahan sebagai bisnis industri kreatif. 
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